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Offline Authentication (Package Plan only)

Activation when changing or replacing your computer
The key is valid for two PCs only when used by the contracted user. 
If you move or replace your computer, you can access your Drill Studio Account to delete the 
registered device information and register a new device. 
If you do not know how to do this, or if you are unable to connect to your account, please contact us 
and we will verify your identity and reset your registered information.

About Version Up
Drill Studio is constantly evolving. 
To ensure that you are the first to use the latest features that become easier to use and add useful 
functionality, you can upgrade to a newer version free of charge during the term of your contract. 
When a new version is released, a notice will be displayed when the software is launched. 
Version upgrades are not automatic, and can be done at any time. 
For those who do not have an online environment (package plan customers), the latest CD-ROM is 
also available.

Changing User Information
The sale, transfer, or loan of activation keys is prohibited. 
If your information (address, phone number, email address, etc.) has changed, please go to the 
Drill Studio Account site to make the necessary changes. 
If you do not understand the process or have trouble connecting to your account, please contact us. 
If we do not have your correct information on file, we will not be able to provide you with support or 
send you important notices.

Offline Authentication allows you to use the 
service offline without restrictions and to 
continue using it after your contract expires.
Click the Offline Authentication button and enter 
all information.
[Click on "Create Application Form" and you will 
see a PDF file like the one on the right.
Once you have faxed or e-mailed this form to us, 
we will send you an offline key within two 
business days by the method you specified. 
The offline key is different from the activation 
key.
Enter the offline key in the "Offline Key" field on the offline authentication screen and press the 
"Activate" button.
 If it is entered correctly, it will be authenticated and unlocked.
Offline authentication can be performed on two computers. 
The same process is required for each computer you are using.



What is Drill Studio?

Drill Studio can do this

Drill Studio is constantly evolving

Drill Studio is a computer software program that allows you to simulate marching band formations 
realistically in 3D, create more effective drill designs, create and print contest sheets, and more. 
Drill Studio is a PC software application that allows you to create 3D realistic simulations of marching 
band formations, create more effective drill designs, create and print contest sheets, and more.
The software can reproduce all kinds of situations, and by exporting to video and applications, you can 
immediately distribute accurate conte sheets to your members. This helps to improve practice 
efficiency and show quality.

● Intuitive creation of contesters
● Placement of performers at precise intervals
● Draw beautiful shapes and curves
● Easy creation of follow-the-leader, pinfields, and other special movements
● Edit and preview from any perspective in 3D.
● Fully synchronized with music, including tempo changes and live sound.
● Create props and other objects at will.
● Flexible insertion and placement of text, graphics, images, etc.
● Various situations such as stadiums, arenas, concert halls, etc. can be handled.
● Flexible design of sheet styles and creation of original contesheets
● Realistic reproduction of various actions such as horn action, turns, steps, etc.
● 3D movements, such as placing a performer on a 3D object, are also possible.
● Automatic calculation of counts and sheet numbers.
● Individual coordination sheets can be generated with a single click.
● Export to PDF files.
● Export videos in MOV or AVI  or MP4 format.
● Upload to server for distribution to the DrillStudioViewer app version.
● Create your own costumes for a more realistic recreation of the marching band.
● Reproduce stage effects with lighting simulation.

Since its release in 2013 as Japan's first full-scale drill design software, we have continued to make 
various improvements and evolutions.
With the cooperation of various orchestras, bands, and instructors in Japan and overseas, we have 
been able to quickly respond to the evolving needs of the marching scene. We are committed to 
providing support that is close to the user and responds quickly to the voices of the people in the 
evolving field of marching.
We use SNS to quickly respond to and improve even the most trivial questions and concerns.

About Drill Studio1
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About the Package Plan

Downloading and Installing Drill Studio

If you purchase a package plan, you will receive the following products.

 Application CD

Installation and Setup2

Drill Studio can be downloaded from the following sites

Download is free, but plan subscription is required to use all features.

Please follow the instructions from the store where you downloaded the software
 to sign up and make payment. 
You can create a Drill Studio Account for any store to use the software on two devices.

App Store

Google Play

1. monthly plan ・・・・・・This is a  monthly contract that renews monthly(auto-renewal) and 
   can be cancelled and re-subscribed in one-month increments.

By downloading and purchasing the application from the App Store 
provided by Apple, it is available for Ipad and MacOS.

2. Yearly Plan   ・・・・・・ This plan is a yearly contract with annual renewal. 
               1 year renewal is required.

3. Package Plan  ・・・・・Available as a CD-ROM package and includes 3 years of support. 
（Desktop only）
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Download and purchase the app from Google Play, 
provided by Google, for use on tablets and laptops with Andloid.

Download directly from the Drill Studio website. 
Mac users can also download the app from the Mac App Store.

Desktop

Ver.

The package plan includes full support for three years from the date of purchase.
After the fourth year, you may continue using supported versions, but older versions 
may become unusable due to OS or device changes.
If the support period has expired, we cannot provide assistance, so regular renewal is 
recommended.
Drill Studio is continuously updated for improvement.
During the contract period, the latest updates can be downloaded via the internet, 
even with the package version.
Paid update CD-ROMs are also available upon request.



Installing Drill Studio (Windows)　

Double-click the icon in the downloaded file or CD-ROM to open it.

A window similar to the one on the right will appear.
 Press [Yes] to proceed.

The following is the install screen on Windows 7.
For other OS versions, there may be some differences in the screen displayed, 
but the operation is basically the same.

The next window that opens is the setup language 
settings. 
This is the language that will be displayed during 
setup and has nothing to do with the language 
of the software itself. Press "OK" to continue.

If you agree to the terms of the license agreement,
check the "I accdept..." checkbox and proceed to "Next".

The CD-ROM also contains files for MacOS, so be sure to click on this icon.

Note: The .exe extension may not be displayed depending on your environment settings.  
File names may vary by version.
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DrillStudio
_setup.exe

AUCS.co

Next, you will be asked to create an icon on your 
desktop. [Please make sure that the "Create an icon 
on the desktop" checkbox is checked, and then 
proceed to [ Next ]. 
Drill Studio does not allow you to double-click on a 
saved file to open it. 
Since they must always be opened from the 
application, please create a shortcut on your desktop 
unless you have a special reason to do so.



When the installation is ready, press "Install" to proceed.

The installation will be done automatically.
Please wait until the process is completed.

When the installation is successfully completed, 
you will see the screen on the right.
Click [ Finish ] and Drill Studio will start automatically.

A splash screen similar to the one on the left will appear. 
If it takes some time to start up If it takes a long time to 
start up, 
the screen will go dark for a while. 
If it takes a while to start up, the screen will go dark for 
a moment, but please wait a moment for it to start up.
When the tools and sheets appear on the screen, 
the installation and Installation and startup are successful.

-5-

Upon startup, a hint screen will appear.
The hints will guide you through the information you need to 
know about using Drill Studio and useful features.



Double-click the icon in the downloaded file or CD-ROM to open it.

If you agree to the terms of the license agreement, 
click "Continue" to accept the agreement and proceed 
to the next step.

After proceeding with the other settings, you will be 
asked for a password to authorize installation.
The password is your Mac personal password.

Installing Drill Studio (MacOS version)

Double-click the icon to mount the disk on the desktop.
The disk is mounted on the desktop and the contents 
of the disk are displayed.
Double-click the displayed package file to execute it.

The following is the install screen on OSX High Sierra 10.13.
For other OS versions, there may be some differences in the displayed screen, but the operation is
 basically the same.

Setup will be executed.
Follow the instructions to complete the setup.

The CD-ROM also contains a file for Windows, 
so be sure to click on this icon.
Note: Depending on your preferences, the .exe extension may not be displayed. 
File names may vary by version.
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DrillStudio_MacOS/dmg



If the passwort is entered correctly, it will be installed 
automatically.
Please wait until the process is completed.

When the installation is successfully completed, 
you will see the screen on the right.
Click [ Close ] to automatically launch Drill Studio.

The Mac version does not automatically start the software 
when the installation is complete. 
An application with the icon on the right will be installed in 
the Applications folder.
Double-click to launch the application.
If necessary, create an alias on the desktop or in the dock.

A splash screen similar to the one on the left will appear.
If it takes a long time to start, the screen will once go dark, 
but please wait a moment until it starts.
When the tool and sheet appear on the screen, 
the installation and startup have been successful.

Upon startup, a hint screen will appear.
The hints will guide you through the information you need to 
know about using Drill Studio and useful features.
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Creating a Drill Studio Account

When you select a restricted function (save, open, print, etc.), the following screen will appear.

You can also sign up for a subscription through the official Drill Studio website. 
After selecting a plan from the purchase page and completing payment, an activation key will be 
sent to you via email. 
Activation gives you access to all features, and the same activation key can be used to activate 
the software on two devices used by the same user.

When purchasing Drill Studio from the official website, creating a Drill Studio account is required.
The account is used to manage payment status and provide support services.
If you purchase Drill Studio from an app store, creating a Drill Studio account is not mandatory.
However, a Drill Studio account is required to use server-based services such as uploading to the 
DSM server.
You can create an account on the official Drill Studio website or via [Help] > [Account Management] 
in the menu.

When paying via App Store or Google Play

When paying via official Drill Studio website 

3

Unlock features restricted by plan contracts
DrillStudio is free to download and install, 
but some features such as saving and video exporting are limited. 
To remove the restrictions and enable all features, a subscription to the respective plan is required. 
Two devices can be activated for any combination of Mac, Windows, iPad, Andriod tablet, etc., 
as long as they are used by the subscribed user himself/herself.

If you purchased from the App Store or Google Play, 
you can use it on the device on which you installed it by signing up for a subscription. 
If you want to use the software on another device, 
you can get an activation key by creating a Drill Studio Account on the official Drill Studio website.

Monthly and annual plans are subscription-based services. 
You can cancel or re-contract at any time, and you can continue to use the software for the term 
of the contract. Only the package plan allows you to continue using the software after the 3-year 
support contract expires. 
However, support will end when the contract is terminated, and free version upgrades will no 
longer be available. In addition, there is a possibility that the software may become unusable due 
to changes in OS specifications, etc., but this is not covered by support.
The cancellation procedure for each plan differs depending on the store where you signed up 
for the plan, so please check the cancellation procedure of each store.

Feature Unlimitation and Activation

After clicking the "Purchase" button, a payment 
confirmation screen will appear on each terminal. 
Follow the instructions to complete payment. 
Once payment is completed, all functions will be 
available. 
If you purchased the app from the app store, you can 
use it offline on the device on which you purchased it for 
the subscription period.
 If you want to use the software on a different device or 
operating system, please create a Driil Studio Account 
and obtain an activation key.

Use all features (1 month update)

Use all features (1 year update)
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Activation

Offline use
When features are unlocked using an activation key, there are limitations on offline use.
You can launch the application offline up to five consecutive times.
If it is launched six or more times in a row while offline, the application will become temporarily 
unavailable.
Once the application is launched in an online environment and re-authentication is completed, 
the consecutive offline launch count is reset, allowing offline use again.
There are no restrictions on offline use for devices purchased under the package plan or via 
the App Store or Google Play.

By logging in with your Drill Studio account, your contract status is applied and the corresponding 
features are activated.
If you purchase Drill Studio from the official website, you can also activate the software using an 
activation key.
Once the key has been issued, launch Drill Studio and select [Help] > [Activation].
Enter your registered email address and activation key, then click [Online Activate].
If activation is successful, the status at the bottom left of the screen will display “Activated.”
After activation, please close Drill Studio and restart the application.
When all features become available, activation is complete.
Even if you purchase the package plan, issuing an activation key is required.
If online activation is not possible due to the lack of an internet connection, offline activation is 
available.
Offline activation is only available to users who have purchased the package plan.
For devices purchased via the App Store or Google Play, all features are available immediately 
after purchase, and no activation is required.

アカウント管理
The Drill Studio account you create can be accessed from 
[Help] > [Account Setting] in the menu.
From this screen, you can manage your account, update registration 
details, or delete your account.
The same actions can also be performed from the account 
management page on the official Drill Studio website.
By logging in on this screen and syncing your app store payment 
status, you can share your purchase status across multiple devices.
In addition, logging in here is required to use the DSM Uploader.
Drill Studio accounts are managed using Google Firebase.
This system prevents us from accessing your password information, 
ensuring secure use.
Your personal information is managed solely by our company and 
handled appropriately in accordance with our privacy policy.
For more details, please visit the official website.



① Create a new drill
② Add performers
③ Load a sound source (if you have one)
④ Create a count
⑤ Design the formation for sheet #0
⑥ Add a sheet
⑦ Design the formation for the added sheet
⑧ Repeat steps ⑥ and ⑦ to complete all performers' movements
⑨ Set up the halt step, horn actions, etc., 
⑩ Adjust label positions so that they do not overlap
⑪ Insert annotations, images, graphics, etc., 
⑫ Print out the Container Sheet and the Coordination Sheet
⑬ Export video and share it with members on video sites, etc.
⑭ Upload to DSM server and share with smartphone apps

Screen Structure and Names

Screen Structure and basic usage

playback control
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Main Flow of Drill Design

Main Menu Tool Palettes

m
ain area
m
ain area

subarea
subarea

Sound wave

SheetSheet arrangement base

Timeline

Count line bar

Count
Subsheet



Types and Roles of the Tool Palette

This tool allows you to select the following modes: Performer 
Placement, Label Placement, Line Drawing, Insert Text, Insert Image, 
Create Object, and Lighting.
The tool corresponding to the currently selected mode is displayed 
at the bottom, and only the parts corresponding to the mode can be 
selected and edited.

It includes save, print, redo, undo, lock, unlock, return to previous 
sheet position, point check, hold, and more. The tool set includes 
tools for saving, printing, redoing, undoing, locking, unlocking, 
reverting to the previous sheet position, point check, 
hold, and collision check. Some tools are hidden by default.

Mode Tools

Edit tools

This is a set of tools that allows you to control the camera to 
change the view of the screen, such as zooming in, zooming out, 
and moving the camera.

Magnify tools
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5

There are three selection methods: rectangular selection, 
lasso selection, and drag selection, 
and three selection styles: select, add, and exclude.

Select tools

close Tool Settings

It is designed so that most tasks can be performed with the tool 
buttons.
Tools can be moved freely by dragging the black area at the top.
Customize the placement of a tool to make it easier to use, and the 
tool's position will be recreated the next time you open it.
Click the × symbol to close the tool.  You can control the visibility 
of the buttons in the Tools menu of the main menu. 
If the tool is out of range and cannot be touched, or if you want to 
return the tool to its initial state, you can use [Tools] ▶ [Reset Tool 
Position] to reset the tool to its initial state.
Pressing the [TAB] key will temporarily erase the entire display. 
If you hold the cursor over any of the buttons, a hint will appear. 
Click on the tool settings to set the tools to be displayed in that 
tool palette and the order in which they are displayed. 
In addition to the tools that are initially displayed, some tools are 
hidden.  Drag the resize button in the lower right corner to change 
the size of the tools.

Resizing

Hold the cursor over each button and wait a moment for a hint to appear.
You can hide a tool by pressing the small X button in the upper left corner. 
Hidden tools can be redisplayed from the Tools menu in the Main Menu. 
Click on the tool settings to set the tools and the order in which they are displayed in the tool palette.
 Some tools are hidden in addition to the ones initially displayed. 
You can change the size of the tools by dragging the resize button in the lower right corner.



Tools to allows you to change the display and hiding of 
black and white views, marks, labels, models, area guides, grids,
 previous point, next point, and forward arrows.

This tools to lets you control 2D mode, fixed vertical rotation, 
fixed horizontal rotation, top view, box view, camera target display, 
spot top, custom camera angles, and stage display.

Object Display Tools

Camera Angle tools

Snap tools
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This tools for snap and interval settings.

Count edit tools
This tools allows for count-related settings such as count 
insertion, count input, count addition, count division, 
count equalization, and measure settings.

Effects tools
Effect effects such as camera action, lighting, shadows, physics, 
and volume can be controlled on/off to reduce processing load.

Playback tools

This tool allows for playback-related controls such as playback, 
fast forwarding, and double-speed playback.

Status Tools

Information about the current timeline is displayed.
You can also use the arrows to move through the timeline by sheet, count, or measure.

Keystroke tools
This tools that enable the same effects as keyboard input, 
such as arrow keys, shift keys, etc.

Sheet edit tools
This tools for sheet-related settings, such as inserting sheets, 
creating sub-sheets, printing sheets, and camera angles.



Tools are available to automatically select various patterns, 
such as auto-ordering, switching the order of selections,
 and skipping one person.

This tools allows you to set up special movements such as 
follow-the-leader and pinfields.

These tools are displayed in 
each mode.
For detailed information on 
how to use the tools, please 
refer to the description of 
each mode.

Performer Placement Tools

Special Move Tools

D-Line Tools Text Tools Image Tool

Tools for controlling selection order. 
Tools are available to automatically perform various types of 
selections, such as auto-ordering, switching the order of selections, 
and skipping one selection.

Select Order Tools

Object Tools Lighting Tools

-14-
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New Drill and Adding Performers6

Selecting a new drill will initialize all information and leave it empty.
 If any items are currently being edited, a confirmation to save will be displayed.

Add Performer

Create a new drill

or Select [File]▶ [Add Performer] to set the Performer.

color setting

Select [File] ▶ [New Drill] to initialize the sheet.

Set the number of performers per part.
 A marching band formation and a preschool marching 
formation are provided.
 Performers can be added or deleted later, but if you have 
created many sheets, you will need to consider the 
placement of the added Performers on all sheets if you add 
them later, so set the correct number of Performers as 
much as possible at the beginning.
 Instruments can be changed during the process.
 Performers cannot be added in the middle of a 
performance.
 You must set up the Performers from the beginning and 
place them outside of the field.
 The number of Performers is not the total number of 
Performers, but the number of Performers to be added to 
the current Performers.
 The additional Performers will appear in the lower left 
corner of the field, aligned by part.
 Depending on the format of the sheet, some parts may 
appear outside the sheet, so zoom out to see the 
Performers created.
Note that if there are already Performers in that location, 
they will appear on top of each other.

The colored square represents the color of the 
mark.
 Clicking on this square will bring up the color 
setting screen, where the color can be changed.
The mark color can also be changed later.
The color setting palette appears in various color 
setting scenarios.
Color changes are in RGB format and can be 
obtained by clicking on the rainbow palette on the 
right.



Brass 

List of instruments that can be set

Trumpet / Flugelhorn / Melophone / French Horn (FB) / French Horn / Trombone / Baritone / 
Euphonium (FB) / Euphonium (SU) / Euphonium / Tuba / Sousaphone

Winds
Piccolo / Flute / E♭Clarinet / B♭Clarinet / Bass Clarinet / Oboe / Bassoon / 
Soprano Sax / Alto Sax / Tenor Sax / Baritone Sax

Battery Percussion

Color Guard

 Snare Drum / Tenor Drum / Bass Drum / Cymbal Line / Glockenspiel / Syrophone

Flag
 Big Flag
 Swing Flag
 Rifle
 Saber
 Dancer

※When 10 or more bass drums are set, all bass drums after No. 10 will be the same size.

※It is possible to change hand tools in the middle of a drill. 
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Pit Percussion

 Glockenspiel / Syrophony / Marimba / Vibraphone / Tubular Bells / Bass Drum / Timpani / 
 Stand Cymbal / Chau gong / Drum Set / Keyboard / Pit Player
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※The pit percussion is an instrument only model.
　Place and use a pit player on each instrument as needed.
　You can also move the instrument by itself.

Prop
Drum Measure (baton)
Sub Measure (baton)
Drum Measure
Sub Measure

Other

About Props

The prop is displayed as shown above.

This is just a temporary object.

You can create props of various shapes 

with the object creation tools and attach

them to create props of complex shapes.

For details, see [Creating a project object P60].
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※ The pit percussion uses the same musical instrument as for adults.
　 You can position the player and adjust the height of the Z, or you can create 
　 a platform and stand it on top of it to simulate a performance.

melody instrument

Keyboard Harmonica
Recorder
Electronic Sax
Keybord
Glockenspiel
Xylophone
Bellrila

Drums

SnareDrum
Trio Tam
Bass Drum
Cymbal
Player

Color Guard
Flag
Pompon
Dancer
Drum Measure
Sub Measure

Male
Female
Boy
Girl

※ It is possible to change hands during the storyboard.

You can customize the model to give a different impression by changing 
the model's hairstyle and costume.

Types of Performer Models



Open File

Double-clicking on a saved dsm file will not open it. 
Even if the file is associated with a file, it cannot 
be opened due to system reasons.
 Please make sure to start Drill Studio and select
"Open" from the File menu to open the file. 
The system remembers a history of up to 
5 recently used files. 
You can open frequently used files by simply 
selecting them.

Import Sound

In Drill Studio, music can be loaded and perfectly synchronized with the movement. 
The length of the conte is proportional to the length of the sound. 
Conversely, it is designed so that conte cannot be written longer than the length of the sound. 
However, if you do not have a sound source or do not need to synchronize with music, a 20-minute 
silent sound source is loaded as a default setting so that you can proceed with your work as-is.
Only WAV or MP3 formats can be loaded. 
For other formats, please change the format (encode) before importing.

Select [File] ▶ [Sound Load] and set the instrument. (When using a sound source)

Initial state

When sound source is set

(20 minutes of silence)

Choose [File] ▶ [Open] and open the saved dsm file.

-19-

Save / Save As

File Open/Save & Import Sound8

The saved file is Drill Studio Motion File (.dsm).
This includes the music data you are using.
The dsm file is the original file for DrillStudio.
It is not interchangeable with other dsm-format files.

You are free to distribute the resulting dsm files, but be aware of the copyrights to use and distribute 
the data, including music files.

or [File] ▶ [Save] and open the saved dsm file.
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Creating and Editing Counts8

Creating a count is mandatory.
Since a sheet is created for the created count, a sheet cannot be created without a count.
Even if there is no sound source and no specific tempo, create a count with any tempo.
Use the Count Tool to create and edit counts.

Create Count

Counts typing

Adds Count

Creates a single count at a timeline location.

Splits the counts before and after a certain location in the timeline by a specified number.

8 SplitBetween these two.

add

Adds a count after the last count currently present, specifying a tempo.

Entering counts

カウントラインベース

Count Tools

カウント

Count Split

Press this button to display the figure on the 
right.
Click the [Start] button to play music and start 
the typing line moving. 
Press the space key on the keyboard or the 
[TAP] button to enter the counts according to 
the tempo. 
If you increase the number of divisions, you can 
enter multiple counts at once with a single tap 
per measure.
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Measure Setting

Counts can be moved or deleted individually. Multiple selections can also be made.

Selected counts can be moved by dragging. When the mouse cursor is in the sheet subarea, 
press ←→ on the keyboard to move and fine-tune the counts.
By dragging from the [ Sheet Placement Space ] starting point, 
you can enclose them in a square and select them all together. 
You can also hold down the [Shift] key while clicking to make multiple selections. 
Right-clicking on a count displays the edit menu.

The variable count is redistributed evenly using real-time input.

Varied count entered in real time balanced count

Count Equalization

This tool allows you to set measures in detail, 
enabling features such as automatic measure 
calculation.
Click the count at the start of a measure to align 
the timeline, then click this button and enter the 
time signature and number of measures.
Measures are set sequentially from the beginning 
of the song.
Set a larger number of measures, then reapply the 
settings at counts where the time signature changes.
By repeating this process, measures are generated 
automatically, and the first beat is shown in green.
To make changes, reapply the settings from the point 
you want to modify onward.
You can also specify which foot to start with at that 
count.
If [Not specified] is selected, the foot is determined 
by the preceding flow.

This feature uses AI to automatically detect and 
generate counts.
It runs automatically when a sound file is loaded, 
and you can click this button to regenerate the 
counts.
In most cases, the default settings are sufficient.
For slow-tempo songs, lowering Max BPM helps 
prevent the tempo from being detected at twice 
the actual speed.
Setting a pickup (anacrusis) or time signature can 
improve accuracy, but songs with complex tempo 
changes or irregular time signatures may require 
fine adjustments after generation.
The audio data is temporarily uploaded to the server
for analysis and is deleted immediately afterward.

Automatic Count Generation



● Move everything after

Right-Click menu on the counter line bar

● Insert count here

　　　

The countline bar is the dark green base area where the counts are located.

 Right-click here to display the menu.

● Add Count By Tempo

Right-Click menu for count

● Create a sheet here

● Even arrangement Count

● Remove all counts

● Measures Set

-22-

Enlarged view of subarea

the same function as.

Creates a new sheet for the count you click.
For details, see "Creating and Editing Sheets P 24".

Deletes the selected count (Red count).
You can also delete them by pressing the Delete key.

Deletes all counts, including those that are not selected.

the same function as.

　　　the same function as. However, the selection count is the starting point.

the same function as, 
However, it adds one count to the location 
where you right-click, not to the timeline 
location.

the same function as, 
However,  creates a specified number of 
counts at a specified interval from where 
you right-click, 
not after the last count.

To facilitate detailed work in editing counts and sheets, you can click on the magnifying glass 
button in the lower left corner to enlarge the subarea.

● Delete seleted counts.



9
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Set the title or subtitle of the show

To set the title, select [File] > [Title Settings].
You can set the title, subtitle, designer, and copyright information.
The information you set here is displayed on the sheet according to the sheet format.
They also have tags assigned to them so they can be displayed anywhere on the sheet.
Title [/ t] Subtitle [/ st] Designer [/ d] Copyright [/ c]
For information on inserting text and entering tags, see [Insert text P48].

Title settings

Title + Subtitle

Display position in the initial format
The display position and design differ depending on the format used.

designer

copyright information
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Change the Sheet Design

You can design your sheets from [Edit] > [Advanced settings].
You can select one of several predefined formats by checking [Use Standard Format] and selecting 
a format. also free to create formats.
You can change the sheet size, grid settings, 
and save your own format designs, such as with the Line tool.
Saved dset files can be opened from this preference.
The configuration file also stores information such as text position and stage type.
It is convenient to save the original design you often use.

Standard format

Changing the Sheet Design (Advanced settings)10

30m x 40m Arena

91.3m × 47.96m Stadium

20m x 10m stage 15m x 7.5m stage

24m x 24m Gymnasium

30m x 15m stage

30m x 40m Gymnasium
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Using a different size than the standard paper ratio may cause unexpected results when printing.

Use the Line tool to draw marker lines, stage 
borders, and other lines to align with the grid.
Use the Text tool to move existing text,
delete existing text, or add new text.
The sheet format is the same for all pages, 
so use tags to make the calculation automatic.
Use the picture tools to modify and add pictures
as needed.

You create a grid by setting the stride, the distance to the 
marker, and the distance of the entire field.
For example, suppose you have a field that is 20 meters 
wide by 15 meters high, with  width 200 and  height 150.
For 1 stride, enter a standard distance of 1 step.
62.5 (cm) for Japan and 57.15(cm) for the United States.
Steps between points specifies how often the thick lines of 
the grid are created.
This is usually 8 (steps) or 4 (steps).

Click the [Set with mouse] button.
The screen will look like the one on the left, so select the 
paper size and hold down the [Shift] key while adjusting 
the bounding box to zoom in and out and adjust the paper size.
The grid does not move, so move the paper and the grid is ideal.
tab page, select the background colour.

See [Insert Text, Shape or Image P51] 
for how to use each tool.

When you create an original sheet, you modify the currently displayed sheet to create it.
Select the closest standard format for ease of use.

　① Change the grid.
　

② Adjust the paper size in the sheet settings.
　

③ Exit the preferences and modify them with the Line, Text, and Image tools.

How to make an original sheet

Please note that the setting unit is different, such as 1 cm or 10 cm.
The grid is just a part of grid paper, so you draw actual markers with the line tool.

Steps between points
8 step

200

1
5
0

1 square is 1 step (62.5)

Text tool

Line tool

Image tool
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You can switch between sheet and stage views with the Stage tool.
You can set different text, images, and shapes for Stage mode and Sheet mode.
Only those created in Sheet mode are reflected in the plot.

Stage settings and changing

Switch to Stage mode

Stage tool

You can change the stage from [View] > [Stage Change].
You can also change the scale and position of the Stage 
from within [Preferences].
You can add objects to the Stage.
Concert hall walls, for example, are created with objects 
that you can modify or delete to change the composition 
of the Stage.
You can also create your own stages by adding objects to 
the Free Stage.

Gymnasium

Stadium

Arena

Stage Small

Stage Large

Free Stage

Change the type of stage



Use the sheet editing tools to create and edit sheets.

Makes the selected sheet a subsheet (or main sheet).

Prevents the selected sheet from printing.
It is possible to set not to print a subsheet, but when this button is pressed, 
the sheet will not be printed regardless of the main subsheet. Sheets with this setting are
 displayed in gray.

Creates subsheets at specified intervals from the previous main sheet to 
the next main sheet in the current timeline location.

Sets the current camera angle as the switching/moving camera for the selected sheet.
A sheet with a camera is marked with a camera mark.

creating with subsheet pitch 2

Only when the Camera button 
in the Playback tool is on.
The set camera work is reproduced.

Sheet tools

Creating and editing Sheets12

Add a new sheet

Create a sheet at the location of the timeline (Current Count).
If a sheet already exists at that location, it is created at the next count.

Create Sheet

Subsheet

Print Lock

Insert Subsheet

Switching/Moving camera

-27-
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Adding and Editing Sheets

If you add a sheet to the end of the list, 
the sheet is created
in the same group as the last sheet,
if you create a sheet in
the middle, the sheet is created in the group as 
of that count.

Right-click a sheet to display the context menu

performer placement during sheet insertion

● to sub (MAIN) sheet

● Camera set

● Camera delete

● Remove Sheet
Remove the selected sheet.

 the same function.

the same function.

the same function.

● Add sub sheet

Deletes the stored camerawork.

● Sheet Dont print

the same function.

Created sheets can be moved by dragging them.
When a sheet is moved, the count numbers and sheet numbers are automatically recalculated.
Sheets are created between the selected count and the preceding count.
This is because the timing when the head position aligns with the point (the off-beat) is used as 
the reference.
As with counts, you can drag from the [Sheet Placement Space] to select multiple sheets 
by drawing a selection box.
You can also select multiple sheets by clicking while holding the [Shift] key.
Sheets can only be moved between other sheets and cannot pass over adjacent sheets.
Sheets cannot be moved to positions without counts. However, if a count is deleted after a sheet 
is created, the sheet will remain.
If you move a sheet in this state, it may shift to an unexpected position, so be sure to recreate 
the counts before moving it.

分割移動
現在のタイムラインの位置より後ろのすべてのシート、カウントをまとめて移動させる事ができます。
曲が変更になり小節が増えたり、カットされた場合に便利な機能です。
赤くなった部分をドラックして移動させることができます。
移動を終了するには、赤くなった部分を右クリックするか、もう一度ツールボタンをクリックします。



Drill Production

The timeline bar represents the current playback position.

●When no performer is selected, pressing the arrow keys (←→) moves the timeline bar.
●Pressing the arrow keys (↑↓) moves the timeline bar to the next sheet.
●Double-clicking the timeline bar moves the timeline bar to the new location.
●You can move the timeline bar by dragging it.
●When a sheet is clicked, the timeline bar moves to the position of the sheet.
●When you right-click on a count, the timeline bar moves to the position of the count.
●When you drag the audio waveform area, you can move the timeline quickly without moving 
　the timeline.
●When the [ Feed Area ] is over the If the mouse is present, you can move backward and forward 
　without moving the timeline.

Working with the Timeline Bar
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13

 Feed Area

Timeline bar SheetCount
Count line base

To edit a drill, first click the sheet you created.
When you click the sheet, the timeline moves to the position of the sheet and the sheet turns pink.
Now, if you move the performer on the main screen, it will be reflected on the pink sheet.
If the timeline is not in the location of the sheet, the current sheet is displayed in light blue to prevent 
unexpected edits.
You cannot select or move performers on the main screen.
If multiple selections are made, the first selected sheet is edited.

As you edit, the sheet in the timeline reflects the caravan situation.
It is designed so that you can see the atmosphere of the current formation at a glance.
Please note that unintended sheets may be edited if you do not always check which sheet 
you are editing.

Basic Operations for Drilling

Sheet 3 is edited.

The edit is locked and cannot be selected.

Sheet 2 is edited.
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Select Performer14

Select Tool

Drag to draw a rectangle and select all performers in the rectangle at once.
The order in which the performers are selected is stored, but if they are selected at
the same time, the order may be irregular.
It is easy to use and convenient for simple actions such as moving and rotating.

You can drag a line and select the performers surrounded by that line.
This is useful for selecting performers in arcs, circles, and other intricate shapes.

You can select performers by dragging them as if you were tracing them with a brush.
You can also click and release once, You can select additional performers in succession 
even after you release the click.
This tool is specialized for sequential selection.
It can also be used for transformational selections.

There are three types of selection tools. Use them according to your needs.
When creating a conte, the order in which selections are made is important.
Choose the tool you want to use by determining how to make the selection according to the situation, 
for example, whether the operation you want to use affects the order.
Selection can also be made by clicking directly on the performer.
Multiple additional selections can be made by holding down the [Shift] key while clicking. 
Right-clicking anywhere other than the Performer will deselect it.

Since this tool is often switched, shortcuts are provided 
so that you can switch between them by pressing 1-6 on 
the keyboard.

Three tools for performer selection

How to use the Select Tool

Rectangle Selection

Lasso Selection

Drag Selection

Only what you specify with the selection tool will be selected.
If you make a new selection, the previous selection is reset and only the newly selected items 
are selected.

Each time you specify a selection with the selection tool, an additional selection is added.
Use when selecting distant groups or when making complex selections.

Deselects what you specify with the selection tool.
Use this when you want to deselect only a portion of the selected performers.

Specify one of three types of effects when selecting with the selection tool.
Selection Effects 

Normal Selection

Additional Selection

Exclude Selection

[1] [2] [3] [4] [5] [6] Shortcut keys
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Be aware of performer selection order

▷ It now appears to show the order you chose.

Depending on the order in which you select the same number of people, the results of using tools 
such as line alignment will change.
In the case of rectangle selection (Select by enclosing it in a box), if you select quickly, you cannot 
recognize the order of selection, and the selection is random.
As you make your selection, slowly cycle through the selections and use the [Shift] key to add 
the selected performer and cycle through the selections. You can also use the Drag Select tool 
to quickly order.
If the ▷ overlap as shown below, the order is not selected correctly.

Depending on your computer's specs and environment, 
there may be a time difference before your choices are reflected, 
and the results may not be in the order you want.
There is a function called auto order to correct them 
automatically.

Move, zoom, rotate performers
You can move a performer by dragging the selected performer.
All selected performers move simultaneously.

You can rotate or magnify using the bounding box.
A bounding box appears when you select the performer.
Drag the      at the corner to rotate, or drag ■ to scale
cange.
Rotating and enlarging, but the mark itself rotates and 
enlarges.
Instead, the performer's points are rotated and magnified
 relative to each other. Therefore, only one person is selected.
In, zooming and rotating are meaningless.
You can also use  ←↑↓→  on the keyboard to make detailed movements.
Pressing [Shift] while pressing allows you to move the cursor at an interval based on the snap setting.
It is useful for tasks such as moving step by step.

Rotate
Scale



Order Determination by Auto-Order

Press this button to reverse the order. 
(You can also use the space key to do the same thing.)

Leave an entire column or row selected and click the Skip button.
You can enter a group (how many people to select) and a skip (how many people to skip) 
to make a skipped selection.

The current selection order can be memorized and restored later.
The memorized selection order persists until the next time Copy is pressed, and is
 overwritten when Copy is pressed again.

When the AUTO button is on, the first selected Performer is first, and the Performers in 
the nearest positions are automatically selected in order.

There are four preset buttons, and when 
each button is pressed, the status is as
shown in the figure on the right. 
Each time the button is clicked, the 
order of selection changes, and 4 more 
patterns are included for each. 
A total of 32 patterns can be selected, 
including the reverse order in reverse. 
Diamond-shaped blocks and diagonal 
blocks are also supported. 
You can easily obtain the desired 
selection order by repeatedly clicking 
while changing buttons or by adjusting 
the selection order before clicking.

The Preset Order tool is automatically selected like a clicked shape.

Auto Order

It is difficult to select many performers as you wish.
This is a useful tool that does those things automatically.

Reverse

Skip
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Preset Order

Copy and Paste



How to use the Performer Placement Tools

Line Placement

Additional Performer

Polyline Placement

Circle Placement

The first click sets the starting point, the second click sets the end point, the line is drawn, 
and the selected performers are placed evenly on the line.

Performers can be added. Performers are added on all sheets.
The Performer will appear in place. Note that if you are using a small sheet setup, such as a 
stage, the Performer will appear outside the column.

Each click increases the number of points and places the Performer on the line connecting 
those points.Right-clicking determines the placement.

Arc Placement

Draw an arc tangent to the first click point, the second click point, and the third click point 
to determine the arc. The selected performers will be placed evenly on the arc.

Curve Placement (Spline Curve)
Each click increases the number of points, and the performer is placed on a smooth curve 
connecting these points. the Performer is placed on a smooth curve connecting the points. 
Right-click to determine the position of the Performer.

Freehand Placement

Box Placement

Drag to draw a freehand line and the Performer will be placed evenly on the line.
Right-click to confirm. You can redraw as many times as you like until you right-click.

Closed Curve Placement (Spline Curve)
Drag to draw a freehand line and the Performer will be placed evenly on the line.
Right-click to confirm.
You can redraw as many times as you like until you right-click.

By dragging a rectangle, you can arrange the selected performers together in a box.
There are certain rules for the order in which they are placed in the box, 
so please be aware of the selection order in advance to ensure that they are placed in 
the intended order.

Click first to center the Performer, second to radius the Performer, and third to place the 
Performer at the desired angle and draw a circle. The selected Performers will be placed 
evenly on the circle.

The Place Performer tool allows you to place performers on 
a line, circle, or other shape based on the selected order.
The order can be reversed by pressing the space key.
There is also a set of alignment tools.
These tools require that the Performer be selected before use.

Performer Placement15
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Mirror Placement
In advance, create half of the shape and select the performers to be mirrored, taking into 
account their order.
Select the Mirror tool, then select the performers you wish to move in order.
The performers will be mirrored relative to the order in which they were selected in 
the beginning.
The starting point of the mirror is the pink line that will be mirrored to the left and right.
The pink line can be moved by dragging it.
It cannot be mirrored up and down, so in that case, create the left and right lines and 
rotate them.

① Select the performers on the side where the 
    shape is completed in order
② Click on the Mirror tool
③ Move to the pink line as a starting point
④ Click or drag to select the opposite performers 
    in contrast to the order of selection
⑤ Select to the end and the tool will be released.   
    To exit midway, right-click

Bezier Curve Placement

Click and drag a point to draw a Bezier curve. Right-click to end the curve.
You can also press [control]+z while drawing a curve to go back one point placement. 
Handles and points can also be selected and adjusted before the curve is determined by 
right-clicking. An even selection of performers will be placed. You can also turn on Interval 
to create a curve with a fixed interval.

Bezier curves can be used to draw complex shapes 
beautifully and are extremely useful, but they are 
also difficult to master.
They are used in a variety of graphics software, 
and there are websites and reference books available 
that explain how to draw Bezier curves in an 
easy-to-understand manner.
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Interval Tool
When this button is turned on, you can draw figures with a fixed interval.
The ▲ and ▼ buttons set the interval to 0.5, but you can set even finer values 
by entering them directly.
Since this is a frequently used function, you can toggle it on and off with 
[I] on the keyboard.

Turning on the magnet button causes the cursor to snap to the point. 
You can change the accuracy of the snap based on the value you set.
With ▲ and ▼ it works at 0.5 intervals, but you can set it as fine as 0.25 by 
entering it directly. 
Snapping affects all drawing tools. If you want precise placement of 
lines, arcs, circles, etc., enable snapping.
When snapping is turned on, an X will appear near the cursor. 
The location of this × is where you click. The snap spacing is always calculated 
from the center (0,0) point.
If the grid is not set up correctly, there may be a discrepancy between the grid 
and the snap.
This is a frequently used feature that can be toggled on and off with 
[S] on the keyboard.

Snap Tool

HandlePoint



Alignment tools for precise placement

With the Align tool, you can align ambiguous points all at once.
Specify a value for the Snap tool and click the Align tool to snap and align to the specified 
point.
The points closest to the specified point will be snapped to and aligned.
Note that larger snap values may cause performers to overlap.

Aligns selected performers vertically or horizontally all at once.

Aligns the selected performers equally vertically and horizontally.

Align vertically and horizontally

Equal vertical and horizontal alignment

Alignment Tool
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Point Check

Reset to previous position

Checks for performers that are not on top of the value set by the snap
(where the snap is active).
Clicking this tool selects the performers that are out of alignment and shows them 
at a glance.

Moves the selected Performer to the previous sheet position.

Halt (in the Edit tool)

Moves the selected Performer to the position of the previous sheet and Holds. 
(no mark time) For more information on Halt (Hold), see [ March Style Settings, P41].

※Not displayed by default. 
　Some tools are not displayed by default.

Editing tools16

Editing tools with a collection of useful functions
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Print
Opens the print settings to print the drill sheet.

Locks the selected Performer or object so that it cannot be edited.

Click to overwrite and save.

Cancels the current operation and returns to the previous state. (undo)
Shortcut Ctrl+[Z] or ⌘+[Z]

Shortcut Ctrl+[S] or ⌘+[S]

Shortcut Ctrl+[Y] or ⌘+[Y]

Shortcut Ctrl+[R] or ⌘+[R]

Shortcut Ctrl+[P] or ⌘+[P]

Shortcut [H]

Redo an operation that has been undone. (Redo)

Unlocks all performers and objects.

Lock / Unlock

Overwrite Save

元に戻す／やり直す



Camera angle settings17

View and edit from various angles.

When the 2D button is pressed, the image is fixed in 2D and is displayed completely from 
above with no perspective.

When horizontal rotation is on, right-click and drag to rotate the camera horizontally.

When vertically rotation is on, right-click and drag to rotate the camera vertically.

When horizontal and vertically is on, right-click and drag to rotate the camera freely.

Camera control can be easily toggled using the Camera Angle tool.

Mouse operation in 3D view

2D View 

The display changes between 2D and 3D, even at the same angle from directly above.

3D View

① Rotate the mouse wheel to zoom the camera.
② Clicking and moving the mouse wheel moves the camera without changing the angle. 
③ Drag the mouse to the right to rotate the camera around the viewpoint.

The MacBook trackpad does not have a mouse wheel clicking action (middle click) assigned. 
You can perform the same action as 2 by holding down the [option] key and dragging, or 
by using the hand tool.

Controls with the Trackpad

Fixing Camera Rotation

Top Angle

Box Angle

Wherever the camera is located, it moves to an angle that looks directly over the entire 
sheet (entire stage).

Moves the entire sheet (entire stage) to an angle viewed from above at an angle, 
no matter where the camera is located.

2D Fixed
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Zoom in or out
Use the Magnify tool to manipulate the screen at will.

Hand Tool
By pressing this button and dragging the screen, you can move it parallel to the current 
angle without changing it. 
The same effect can be achieved by dragging while middle-clicking the mouse button 
(clicking the wheel) or holding down the [Alt] key in Windows or the [option] key on the Mac.

By pressing this button and dragging the screen, you can change the angle around the 
camera target.
The same effect can be obtained by right-clicking and dragging the mouse button, 
or by pressing [Alt]+[command] on Windows or [option]+[command] on Mac.

Zoom in/out
Zoom in and out without changing the current angle.
Moving the mouse wheel produces the same effect.

Change Angle

Custom Angle
This button allows the current camera angle to be memorized.
It is hidden by default.

This button allows you to set the camera angle to the stored camera angle.
This button is hidden by default.

You can switch between stage display and sheet display.
For details, see [Setting and Changing Stages, P26].

Stage Display
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Target
Displays the camera target. The camera is always aimed at the camera target.
Click this button to display the current target position and help you navigate the camera.
Even if it is displayed, it is not affected by printing, but it will appear on movies.

Spot tool
Click this button to change the camera target to an angle from directly above.
Use the Target button to view the current camera target position.

Camera Target



Show/Hide area guide

Part Display Tool

18

Show/Hide previous point

  Show/Hide next point

A line will be drawn between the point on the previous main sheet and the current position
 from that point.
Showing or hiding the line is also reflected in the printed result.

A line will be drawn connecting the point on the next main sheet to the current position. 
Showing or hiding the line is also reflected in the printed result.

The area guide works in conjunction with the count to help you determine the approximate 
limits of your moving stride. 
A circle is displayed with a radius centered on the previous point that is the width of the 
count*1 steps. 
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Show/Hide selection order arrows

Toggles between showing and hiding the arrows that indicate the order of selection.
By default, this tool is hidden.

Shortcut [Q]

Shortcut [W]

Shortcut [E]

Shortcut [Y]

Show/Hide model

Show/hide performer mark

Show/Hide performer label

Temporary performer mark in black

Show/Hide grid

Various parts can be shown or hidden.

Display of Mdels and Marks

Chenge to Show/Hide

Shortcut [M]

Shortcut [X]

Shortcut [B]

Shortcut [L]

Shortcut [G]

It is a tool that I switch to often, 
shortcut keys are provided.



各ボタンについて

音量の調整

Play, Stop, and Fast-Forward drills19

Status Tool

Playback Tools

The status tool always displays the current set number, count, and measure information.

You can use this tool to control playback, rewinding, etc.
If playback does not work, please make sure that the sound source is set and saved in a supported 
format.

The sheet number and count are set automatically.
When a measure setting is made, the measure and beat counts are also calculated automatically. 
You can also use ◀▶ to move the timeline by sets, counts, and measures.
In the above figure, the current set (sheet) is [No. 4], the count for this set is [8], and it is 
currently beat 5, [beat 1 of measure 5].

You can head out.
Go to the head of the show or to the head-out point.

Play the show.

Clicking this button brings up the tools below to adjust the volume.

Clicking on the metronome toggles the click sound on/off, 
and clicking on the notes toggles the sound source on/off.
You can adjust each volume with the slider.

When this button is pressed, playback will be at 3x speed.

When this button is pressed, playback is at 1/2 speed.

Rewinds the timeline.

Fast-forward the timeline.

-40-

Shortcut [SPACE] 
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ホルト（ホールド）ツール
Select a Performer and click this button to halt the selected Performer.

If the selected Performer has a halt designation, the color will be blue.
If the selected Performer has a mixed halt designation, the color will be green.
Clicking again while the color is blue or green removes the halt.

If a halt is specified, the toes open and remain stationary on the spot.
If the performer is moving between sheets, he or she will automatically return to the point on t
he previous sheet.
Halts are performed between sheets and cannot be set in detail by beats.
If you want to perform a halt & move in the middle of a sheet, please create a sub-sheet.

Shortcut [H]

Halt  ・ ・・・・rest at previous point

Low Step  ・・Lift your foot up slightly to the ankles.

Middle tep ・・'m going to raise my legs to my calves.

High Tep   ・・ift your feet up to your knees.

The following will automatically point
 in the direction of travel.

FreeWalk 1   ・・Walk regardless of tempo.

Free Walk 2  ・・Walk fast regardless of tempo.

Free Run ・・・・Dashes regardless of tempo.

Set March Style

Step Change (Low, middle, high step, etc.)
Select a performer and use [performer] > [step change] to change the knee-raising 
height of the specified performer.

The default is to move in row steps.
Any changes you make here are reflected in the
selected sheet. (Multiple Selectable)

Step Time (Normal, Double, Half-time)
Select a performer and use [performer] > [Step Time] to walk your chosen performer to double 
or half the tempo.

This setting is valid for only one sheet.
If you want to continue with multiple sheets, 
select the sheets you want to reflect and 
set them.
The drill studio has a function to automatically 
calculate measures and counts. 
So instead of inserting a lot of counts, 
even if you move the whole thing at double 
tempo, set it to the score and set a double 
time for all performers.
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Select the performer and choose [Performer] > [Turn settings].
Each person can set the turn by seat.

Turn settings

The turn occurs between the previous sheet and 
the current sheet.
There are three types: travel direction, look point, 
and angle specification.
The rotation starts from the start count and reaches
 the specified angle at the end count.
When turn settings are made, the angle is 
maintained until the next sheet on which the turn 
settings are made.
For example, if you want to stop the direction of 
travel and turn to the front, set the turn at 0 degree 
angle at that timing.
By using setting 2, you can set 2 types of turns 
between 1 sheet.
Setting 2 is for angle only.

You can set the angle with the ▶ button.
Orients to the specified direction at the specified timing.
The button is set to 45 °, 
but you can specify a smaller angle by entering a number.

Orient to the direction you want to go.
Always goes forward for any angle.

Always points at the point where you click.
Continues to point as your location moves.

Specify angle

Direction of

Look Point

Set Action

Delay Setting
Delay is a function to shift the timing according to the performer's 
selection order, and select a number between 1～4 beats in turn setting.
For details, see [Horn Action Delay Settings P 41].
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Delay Setting

Select the performer you want to configure [Performer] > [Horn action].

Horn action

Applies instrument, arm, and neck poses, such 
as horn-down and horn-up, to the selected 
performer.
Affects the previous sheet to the current sheet.
For example, when a performer who is in a 
horned-down state is horned-up, the bell is moved
 from the start count to the end count.
After that, unless instructed, bell up will be 
continued.
If you want to restore, set again.
Horn action is different for each instrument.
Changing the number changes the selected 
performer's pose.
Move the window and make sure that the desired pose is set.
By using setting 2, you can set two kinds of actions between one sheet.

Delay is a function to shift the set timing according to the performer's 
selection order.　Choose a number between 0.25～2.
0.5 is a half beat and 1 is a beat offset.
By setting the group, the action is performed in units of the set number 
of people.

When a group is set to 1, each person moves one 
by one, 
so the action is like a wave.

If the group is set to 3, the action will be performed
in groups of three.

Delay is available only between sets (between sheets).
Once you set the delay, the delay is unchecked when you open the horn action again.
In case of resetting, re-check.
Use the Offset Copy tool when you need to perform actions across subsheets.
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Various poses can be made.
Select the performer and choose [Performer] > [Pose library].

Pose library

Unlike the horn action, the pose is the same for 
all parts.
The poses you can set here can be set to move 
other than the part that works in the horn action
 (arm, neck).
Changing the number changes the selected 
performer's pose.
Move the window and make sure that the desired 
pose is set.
By using setting 2, you can set two kinds of 
actions between one sheet.
Like the horn action, you can set the delay.
See the Horn Action page for details on working 
with delays.

The motion follows the motion number in sequence.
Even with the same number, the operation differs 
depending on the part and section, 
and the direction of the drum measure, 
toss and spin of the flack, etc. are prepared in 
advance for each section.

The length of the set motion depends on the part 
or number.
If the length from the start count to the end count 
is longer than the length of the action, the motion 
is repeated; if it is shorter, the motion is played 
halfway.
The motion assigned to each section or instrument
 is different.
Normally, the lower body prioritizes walking, but you 
can set motion for the lower body by checking 
Lower Body Motion. By using setting 2, two types 
of motion can be set between one sheet.
If you select multiple sheets and check 
[Apply to all selected sheets], you can set the same
 motion for all selected sheets.
The delay can be set in units of one beat.

Motion library
You can have them perform various sequential actions.
Select the performer and choose [Performer] > [Motion library].
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The Walk Behavior (Low step, double time, etc.), Hold, and Pose libraries fit into this range.
Pose library has priority over hold and hold over walking.

Using the March, Turn, Horn Actions, Pose Library, and Motion Library, you can create more 
than 300 poses.
You can configure complex actions by adjusting the timing of the actions.

Upper: Horn [4]
Lower: Free run

Upper: motion [3]
Lower: poses [11]

Upper: motion [1]
Lower: poses [2]
Turn [270]

Upper: Horn [5]
Lower: pose [1]

The settings in the Horn Action are applied to this range.
The actual control is not over the upper body, but over the arms, neck, and hand-held instruments 
and sticks, so the rotation of the hips is controlled by the Pose Library.

Precedence of various actions
Upper body action

Upper body action

Full-body action

Multiple Configuration Example

Lower body action

Lower body action

Full-body action

楽器 楽器楽器 楽器 楽器 楽器

The motion library usually applies to actions on the upper body only, 
but you can set motion on the whole body by checking [lower body motion].
You can also blend with poses (lower body) if [lower body motion] is not checked and 
you have a pose library set up.
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Follow The Leader / Pinwheel

Free move

② Select the sheet before the move, not the sheet 
    you created.

① Create a temporary sheet (Sheets in the set to 
    free move) after moving it.

④ Click the Free Move tool.

③ Select the performer you want to free move.

⑤ Set the desired spacing for subsheet pitch and 
    click Create.

⑥ Click the mouse to enter the movement.

You can continuously set the movement of a single performer's subsheet.
This allows you to express curvilinear free movement.

This feature is enabled when only one person is 
selected.
The finer the subsheet pitch, the smoother the 
movement will be, but you will have to consider 
the movement of other performers as well.
If there are no subsheets, subsheets are 
automatically created.
If there is already a subsheet, the position 
information is recorded in the subsheet.
When you reach the next sheet, the input is 
automatically finished.

Special tool that makes it easy to create complex movements
Provides tools that make it easy to create complex 
movements with a variety of subsheets.
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Auto Follow Tool (FTL)

① Create sub-sheets between sheets 
　 and design the movement of the lead 
　 performer.
　 Using the Free Move Tool allows you 
　 to create this quickly.

② Select all sheets that will use Follow 
　 the Leader.
　 Select the performers to follow in order, 
　 including the leader.

③ Click the Follow the Leader Tool.
　 You can configure multiple groups 
　 at once using the Group Size setting.
　 Normally, this is set to 1.

④ This creates Follow the Leader movements 
　 with TP1 as the leader.

Auto Follow tool is create movements that follow a specified performer.

In this setup, TP2 Sheet 1-1 is placed at the position of TP1 Sheet 1,
TP3 Sheet 1-2 is placed at the position of TP2, and so on.
Each performer moves onto the previous performer's point two beats later.
This is a basic Follow the Leader pattern, but more complex patterns can be created by 
adjusting the Sub-sheet Pitch, setting it to 1, or using Skip settings.

Parade formations like the one shown on the right also follow
the lead performer and can be created using the Auto Follow Tool.
By creating movements for the first five performers in advance 
and setting the Group Size to 5, you can configure five columns 
at once.

The leader's movement can be created efficiently using the 
Pinwheel Tool, which is explained on the next page.

This allows you to create Follow the Leader movements, such as following a leading performer 
or creating outer-circle parade formations.
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Pinwheel (PW)

Subsheet Interpolation

Pinwheel is a function that rotates a line or group about a specified point.

① Create a temporary rotated sheet 
    (Sheets in a Rotating Set).
② Select the sheet before the move, not the sheet you 
    created.

③ Select the performer you want to rotate and click the 
    Pinfield tool. 
    Selection order has no effect.

④ Set the subsheet pitch and count total.
    The finer the subsheet pitch, the smoother the rotation, 
    but the more subsheets there are, the harder it is to edit 
    later.
    Count Total specifies the number of beats to complete 
    the rotation.

⑤ Click the center point with the mouse to draw the rotation.
    The maximum rotation is 180 degrees. If you want to do
    more rotation, do it in two batches.
    In addition, the point may shift slightly due to calculation 
    error in the 180 degree pin field, so make a fine 
    adjustment after setting the pin field.

The pin field setting is done by count specification,
not between sets, so it may be set beyond the sheet.
The rotated sheet should be carefully positioned, or should 
be positioned at the back with room for adjustment.

Interpolates the positions of the intervening subsheets in a linear motion from the position of the 
previous main sheet to the position of the current sheet. 
You can use it to translate another group of performers with a detailed subsheet, 
such as a follower reader or a pin feel.

This tool is valid between main sheets.
If you want to interpolate from the middle of a subsheet, you can switch to the main sheet once, 
interpolate, and then return to the subsheet later to interpolate from the middle.

Subsheet Interpolation tool
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Offset Copy
You can make the same movement for each specified group.
You can copy not only movements, but also horn actions, poses, and so on.
Skip lets you shift the timing to create the effect of the wave.

Similar to the following leader, but follows the leading motion
Instead, all selected performers do the same thing, without beats.
I'll come and do it.

Set the number of groups you want to perform the same movement 
at the same time.
Skip is the number of subsheet skips.
If subsheets are created per beat, skip 2
It is a movement of 2 beats.
In the case of a subsheet for every 2 beats, if it is skip 2, 
the movement is shifted by 4 beats.
to set the options.
Quickly perform various actions such as subsheet pitch, setting 
value, and selection order to create them.

You can also set the skip to 0 and do the same thing at the same
time.
You can copy only steps and step times, not just motions.

Offset copy copies only the differences that have been moved to 
the specified sheet, regardless of whether the movement is on 
a subsheet or the main sheet.

If you think of performers A and B as skipping 2, the 1 -1 on A 
becomes the 1 -3 on B.
At this point, B moves from the point at 1 -3 to the point at 1 -1, 
so the result changes depending on where B is at 1 -3.
Since 1 -4 of B is calculated from the position after 1 -3 of B has 
moved, any position after 1 -4 of B is overwritten, so it does 
not matter.
This allows you to create special movements.

B1 -1 Original Position Remains

A
B
C

B1 -2 Calculated from Original Position

The original position is ignored because it is determined from the 
calculation of B1 -2.
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Parade Turn

Cross Spin

combination of special tools

① Place the performer and create the main sheet after 24 counts.

② Use       to create a 90 degree pinfield in the first column 
    with a subsheet pitch of 2 and a total count of 16.

③ On the last sheet, move the first column 8 steps to the left 
    and add a subsheet at pitch 2.

⑤ Go to the last sheet, select any column other than the first,
    move it 24 steps down, and click      .

⑥ Move to the first sheet, use the Z button to select it, 
    move to the last sheet, and click       .

⑦ Set the group to 5 and the skip to 2, then press OK.

The parade turn is completed as shown on the left.

① Place the performer as before, and after 24 counts, create 
    the main sheet.

③ Change the sheet in the first subsheet (1 -1) to the 
    main sheet.

④ On the last sheet, move the first performer 22 steps to 
    the right and click       .

⑤ Move the non-first column down 24 steps, and click      .

⑥ Use the Z button to select the first sheet, move to 
    the last sheet, and click       .

⑦ Set the group to 5, set Skip to 2, and press OK.

The cross turn is completed as shown on the left.

Turn settings associated with a direction change can be set 
to all by using the delay function of turn settings.

② Move to the last sheet and create a subsheet at pitch 2.
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パフォーマーマークの編集

Performer Mark and Performer Label

Edit performer mark

The center of the performer mark is where the performer stands.
This mark is expressed in text and can be changed freely.
Click [Performer] ▶ [Properties].
If multiple performers are selected, all are affected.

You can change the color and size of the mark.
If you check the item you want to change, you can edit the value of the item.
If you change the text of a performer mark, the center may shift depending on the type of 
characters, such as symbols.
To prevent this, you can adjust the offset finely.
When [+ Sequential] is checked and a starting number is set, a sequential number can be 
automatically set after the mark or label.
It is also possible to give a sequential number to everyone by leaving the label text blank and 
setting a sequential number.
You can also use this property to change the performer's hat, texture, and so on.
For details, see [Original costume settings P64].

Br12 Br1212
Mike

Performer mark

Label
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Move label position

Depending on the formation shape, the labels may overlap and be difficult to see.
You can only move the label location on each sheet.

Label Position Mode

You can select and move labels by turning on Edit Label Location.
The moved label affects only that sheet.
If you want to affect all sheets, use the offset of the label position by [Properties] on 
the previous page.

Label position editing can be used in conjunction
 with a variety of tools, such as zoom, rotate, 
and line and arc tools for easy viewing.

When you finish editing the label, press the Edit 
Label Positions button again to turn it off, 
and the performer mark will be in normal mode 
for selection.

Return the label to its initial position
Return the performer's label to its normal, unmarked position on [Performer] ▶ [Reset label position].
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Insert line or shape

D-Line Edit Mode

You can draw a variety of shapes with the draw line tool.

Click on the start and end points to draw a line.

All lines are connected and created with each click. Right-click to confirm.

Click on the start and end points to draw a rectangle.

The first click determines the center point and the second click determines the size.

Draw an arc through the first click point, the second click point, 
and the third click point to determine the arc.

Drag to draw a line freely.

Repeat clicking to draw a beautiful curve. (Spline curve)

Repeated clicks draw a closed, clean curve. (Closed Spline)

Drag a handle to draw a Bezier curve.

The Point Maker tool sets the name of the point. 
It appears only when you are in All Sheets mode. See [P63] for more information.

Single sheet / all sheets sheet / stage

Insert Shapes, Texts, Images

With the D-Line tool
●Line Color
●Line Weight
You can set the.

Click the Edit Line Mode button to display the Draw Line tool.
Line editing mode can be broadly divided into
There are four modes.

① Draws a line single sheet with only one sheet specified 
    pressed.
② Create in the state that all the line sheets which are 
    commonly displayed in all the sheets are pressed.
③ Create in the 3D stage mode with the line single 
    sheet + stage mode pressed, which is displayed with 
    only one specified sheet.
④ In the 3D stage mode, the line that is commonly
    displayed 
    on all sheets is created with all sheets + stage mode 
    pressed.

Lines in 3D Stage mode are not plotted.

D-Line tool
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All black lines on the default sheet are 
created in line edit mode.
(All Sheets Mode)
 
Blue lines are createdby grids.

All marker lines on the Stage are also created 
in line edit mode.
(All Sheet Mode + Stage Display)

Blue lines are created with a grid.

You can delete and edit these lines to create the original marker lines.

If you want to delete a shape, right-click the shape and choose Delete [Delete].
You can also delete them by pressing the [Delete] key.

You can move shapes by dragging them.
If you are not in line edit mode, you cannot select or move.
Shapes created in All Sheets mode can only be selected in All Sheets mode.
(Geometry created in all sheet modes cannot be selected in single sheet mode)

If you want to edit a shape's points, double-click the shape you want to edit.
The points are then displayed and you can move them.
However, you cannot modify points on lines created with circles, ellipses, or pens.



Clicking the Text Edit Mode button brings up the Text tool. 
There are four main text editing modes, as well as line 
and image.

① Text displayed on only one sheet specified  
    Created with a single sheet pressed

② Text that is commonly displayed on all sheets  
Text displayed on all sheets
③ In 3D Stage mode, text displayed only on the 
    specified sheet.  
    Created with a single sheet + stage mode pressed

④ In 3D Stage mode, text commonly displayed on all 
    sheets  
    Created with all sheets + stage mode pressed

　Lines in 3D Stage mode are not reflected in printing.

Text Edit Mode

Text Tool

Inserting Text

In text edit mode, double-click and drag anywhere to insert 
a text box.
By creating a text box of the required size in advance and 
entering text in it, you can place text anywhere you like.
You can freely change the text size and background. 
By not using a background, only text can be placed.
You cannot change the color of the text in the middle of 
a text box. 
If you want to change the color of only a part of the text, 
you must create multiple text boxes on top of each other.

With the Text tool
● Font size, font color 
● Line spacing, text alignment
● Background, background color
● Border color, border thickness 
You can set the.
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How to create a text box

Single sheet / all sheets sheet / stage

Text and background 
colors can be changed.

Text and background 
colors can be changed.
Text and background 
colors can be changed.



Tag input (auto-calculation)

Editing and Deleting Text

The default sheet has 7 text boxes created in all sheet mode.

①  Title + Subtitle "[/t] [/st]"
② Designer "Designer:[/d]"
③ Copyright Information "[/cp]"
④ "Set No."
⑤ Number of sheet number "[/s]"
⑥ “Counts”
⑦ Counts number "[/c]"

To edit text, double-click on the text box to switch to edit mode and text can be edited.

To delete a text box, right-click on the box and select [ Delete ].
You can also delete a box by pressing [delete].
Boxes can be moved by dragging. 
If you are not in text editing mode, you cannot select or move a box. Also, text created in 
all-sheet mode cannot be selected when not in all-sheet mode.
(You cannot select a text box on a single sheet when in All Sheets mode.)
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If you try to edit the title in the upper left corner, 
you will see something like this. This is called a tag.
The title and subtitle are done in the title settings.
The set information will be displayed where this tag is inserted.
When you finish editing, it will be converted automatically.

Title tag [/t]

Subtitle tag [/st].

Title＋「　」＋Subtitle　It goes like this.

space

space

Tag and character combinations
Enter [/○] for the tag.
The area enclosed by [ ] will be replaced by the contents of the specified tag.

For example, if you enter the following

The tag portion is replaced and the current sheet number, count, etc. 
are automatically calculated and converted.

The calculations are automatic, even if the sheet array is changed or the counts are changed, 
so that the display is always correct.
Calculations related to measures, such as [/ms] [/me] [/meas], require a measure setting.

The current sheet is the #[/s].　The count for this sheet is [/c].

The current sheet is the #21.　The count for this sheet is 16.

Tag List
Sheet number (12, 12-2, 12-A, etc.)Sheet number (12, 12-2, 12-A, etc.)

Count (count from previous sheet if sub-sheet is printed, count from 
previous main sheet if no sub-sheet is printed)
Count (count from previous sheet if sub-sheet is printed, count from 
previous main sheet if no sub-sheet is printed)
Count of all counts up to that sheetCount of all counts up to that sheet
Title set in Title settings Title set in Title settings 
Subtitle set in Title settings Subtitle set in Title settings 
Designer set in Title settings Designer set in Title settings 
Copyright information set in Title settingsCopyright information set in Title settings
First measure of the sheetFirst measure of the sheet
Last measure of that sheet Last measure of that sheet 
Number of measures on that sheet (one measure counts even if it is 
in the middle of a measure)
Number of measures on that sheet (one measure counts even if it is 
in the middle of a measure)
Start beat of that sheetStart beat of that sheet
End beat of that sheetEnd beat of that sheet
Compound notation for the measures of the sheet
 (22-24, 22(1-2), 22(3)-24(2), etc.)
Compound notation for the measures of the sheet
 (22-24, 22(1-2), 22(3)-24(2), etc.)
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Title setting
Title

Subtitle



Insert image

Create an image box at the appropriate size and set the image in it. 
Click the Original Size button to adjust the aspect ratio to the original.
Hold down the [Shift] key to zoom in or out while keeping the aspect ratio fixed.

Double-click & drag anywhere to create an empty image 
box.
Select the created box, then browse for an image with 
the Image Tool and select it from a file.

Image Edit Mode

Image tool

With the Image tool
● Insert image
● Image opacity
● Image overlap order
You can set the.
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Clicking on the Image Edit Mode button brings up the 
Image Tool. 
There are four main image editing modes, 
as well as line and text editing modes.

① Image displayed on the specified sheet only    
    Created with a single sheet pressed

② Image commonly displayed on all sheets
　 Image created with all sheets pressed

③ In 3D Stage mode, an image displayed on the specified 
    sheet only.
    Created with a single sheet + stage mode pressed

④ In 3D Stage mode, an image commonly displayed on 
    all sheets
　 Created with all sheets + Stage mode pressed
　Lines in 3D Stage mode are not reflected in printing.

How to create an image box

　

Single sheet / all sheets sheet / stage



As with text and graphics, separate images can be created for the stage and for the sheet.
By preparing a processed image for the sheet, it is possible to create a sheet that is easy 
to view when printed.

To delete an image, right-click on the image you wish to delete 
and select [ Delete ].
You can also delete an image by pressing the [delete] key or 
the trash button.

The transparency of the image can be changed to make the performer more visible or 
inserted below the grid. The image can be enlarged or reduced using the bounding boxes 
in the four corners that appear when the image is selected. To return to the original image 
size, press the Original Size button.
Hold down the [Shift] key while zooming in or out to fix the proportions.

本来の画像 印刷用に薄く加工
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Remove
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Used as a prop

Creating Prop Objects25

Using the Object tool, you can create objects for props 
and stages.
Objects can be exported and loaded into files as object 
groups.
The object group data is also included when the dsm 
file is saved.
Six types of objects are available: planes, cubes, spheres, 
cylinders, cones, and triangles. Each object can have 
a texture.
Transparent PNGs can be used to create props of various 
shapes.

When a prop is created from Add Performer, it will appear as shown on the left. 
Create an object of the desired shape with the Object Tool beforehand. 
Select the prop and choose [ Performer ] > [ Properties ]. 
In the Properties window, check the [ Attach Object ] checkbox and set the 
object you created in advance. 
At this point, the original brown panel is still there, so check [ Hide original model ] 
to hide the original model. 
The object will now be a prop that can be moved.

Object Edit Mode

Object Tools
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Placement of performers on top of objects

Used as a stage
When creating an object group, check the [ For Stage ] checkbox to create the object as 
a stage-specific object.
These objects are displayed in stage mode and cannot be moved. 
The stage echo boards and other elements of the small and large stages provided as standard 
stages are created using these stage-specific objects, so stage layouts with a high degree of 
freedom can be created by deleting and rebuilding these objects.

Select the Performer and choose [ Physics Collision ] in [ Performer ] > [ Properties ] 
under [ Move Method in Z ] to allow the Performer to climb the object.
Vertical steps are limited in height (about 1 meter).
If you want to put the object on a large high platform, create a ramp or stairs. 
The object can be used as a platform for both stage and prop.

If Collision Processing is unchecked, the prop is ignored and penetration is performed.
 Since the collision processing is performed by the physics engine, the collision may not be 
properly handled when playing back from the middle of a scene or reversing a scene, 
so playback should be started a little earlier.
In addition, you can set the Performer's position in the Z direction on a sheet-by-sheet basis 
by selecting [Specify Z value] in the [Z direction movement method] menu. Select 
[Performer] > [Change Z position]. 
This setting allows the Performer to move in the Z direction as well as in the X and Y 
directions on a sheet-by-sheet basis, so that the Performer can float in the air even without 
a prop or other base. 
As with normal point movement, the movement between sheets is automatically interpolated. 
However, if collision processing is checked, the falling physics calculation is given priority 
even when floating in the air.
　

Turning off the apple icon in the Effects tool will force the 
physics to stop.
However, this is only temporary. If you want to completely 
stop the physics, set the "Move Z" method to "Z value" 
for all performers.
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How to operate the Object Tool

To create an object, first create an object 
group using the New button. 
Name the object group and use the buttons 
to place the objects. 
Rotate, move, and zoom together to create 
the desired shape. 
It is difficult to create complex shapes 
because basic shapes are processed, 
but you can create a variety of objects 
depending on your creativity.

[ Luminance ] Check this box to make the object unaffected by the lightness or darkness of the 
lighting.  This has the effect of making the object appear as if it is emitting light when the main 
lights are dark.  Combined with lighting, this can be used to create effects such as a glowing 
stage background or a glowing ball.
　　

Each object can be textured.
Texture mapping layouts are available on the official Drill Studio 
website.

This button allows you to show or hide the Performer.
Use this function when it interferes with the creation of an object, or when you want 
to compare sizes with the Performer.

[ Join ] button to group them together.
[ Separate ] button allows you to ungroup.
[ Duplicate ] button allows you to copy objects. 
          

[ Mirror ] button allows you to flip the object.  
[ Delete ] button allows you to delete the selected object.

When creating multiple large objects, they tend to overlap, so they can be subdivided into object 
groups and used like layers for easier editing.

e Note that the objects will be copied to the same location, so they will overlap.
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Lighting settings26

The lighting tool allows you to set the placement and 
effect of lights that will be reflected when the stage 
is displayed.　Detailed light settings can be made on a 
sheet-by-sheet basis.　Light actions are applied to the 
next sheet for which a light action is set.
There are three types of lights.

This light illuminates the whole area like the sun.
One is set as the main light from the beginning.

Directional Light

Light switch. Uncheck to turn off.
[ ON ]

The effect is to change the light to seven different colors.
[ Rainbow ]

Flash effect.
[ Flash ]

The intensity (brightness) of the light.
[ Intensity ]

Affects only the spotlight. You can adjust the size of the spot.
[ Size ]

Affects spotlights only. Allows you to adjust the intensity of the spotlight beam.
[ Beam ]

Affects point lights and spotlights. Allows you to adjust the range of the light.
[ Range ]

Allows you to set whether or not the selected light will cast a shadow. 
The shadow button in the Effects tool temporarily removes the shadow,
but unchecking this checkbox prevents the shadow from being drawn even if 
the shadow button is on.

[ Drop Shadow ]

You can select one of them. Swing and Rolling are performed at a fixed speed.
If you check [ Invert ], the direction of rotation is inverted.
If you choose Follow, select the Performer you wish to illuminate with the Settings button.

[ Static ] [ Swing ] [ Rolling ] [ Follow ]

This light emits light in all directions and is similar 
to a light bulb.

Point Light

Directional spotlight.
Spotlight

Lighting Editing Mode 

Lighting Tool 



Texture Settings

You can set up your own costumes in [ Edit ] > [ Costume Settings ].

Image editing software is required to create textures.
Please use software that can export in transparent PNG format.
Only PNG format can be used. Texture maps and samples can be downloaded from the Drill Studio 
download page.

Original Costume Setup27

The polygons of the model are divided into body, costume, shoulder armor, and skirt.
Parts can be excluded by making the relevant parts of the unwanted texture transparent.
Skirts and sleeves can also be shortened or made into half-skirts by using different textures.
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Model Texture

You can create your own original costume set 
by setting the hat type, costume texture, color, 
etc.  Costumes set here are set in sections 
and set to a shared material.  This reduces the 
load on the screen rendering process 
(rendering) and can be saved as a costume 
set.  If you wish to set up costumes by section, 
and then set up individual items with different 
colors and patterns, such as a hat for a drum 
major, you can do so by going to [ Performer ] 
> [ Properties ].



Change hats, battery instruments and flag colors

Each hat can also be textured.
Hat textures vary for each hat.
Use the mapping layout corresponding to the hat from the texture 
sample data. layout for that hat.
Sample data may be freely modified for use within Drill Studio only.

Sheiko Hat Hat 1 Hat 2 Hunting

Military Helmet

Busby Hat S Busby Hat L

Hair 1 Hair 2
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Type of hat

Battery Color

Flag Texture

The battery body (shell) can be set 
to a color and texture.  If a texture is 
set, the color must be set to white to 
get the original color.  Shell texture is 
a pattern only, and the pattern may 
be shifted if there is a connection of 
surfaces such as letters.
 Only for bass drums, the head 
texture and color can be set.

Flags can also be textured.
By using transparency, the shape of the fabric can be changed.
The default flag is shown on the right, with a white and pink 
texture set and the color set to yellow, resulting in a 
yellow-orange flag.
As you can see, by using the texture in conjunction with the color 
well, it is easy to change the color.



Exporting Movie

Print settings and PDF export

Exporting movie and printing28  
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Click [ File ] > [ Print ] > [ Drill Sheet ] to open the 
print settings window. 
If you check "Print sub-sheets", all sheets including 
sub-sheets will be printed. 
If you check "Print in B&W", the Performer's mark will 
be printed in B&W. If you check "Print in color", the 
Performer's mark will be printed in color. 
This will prevent light colors from becoming light gray 
when printed in B&W. Logos, lines, etc. will remain in 
color.
 Click [ Export PDF ] to save the file as a PDF file.
[Clicking the Print button creates a PDF file as a 
temporary file and opens the default PDF viewer. 
In Drill Studio, the detailed settings for printing 
depend on the PDF viewer in order to achieve 
multi-platform and stable operation regardless of the 
environment.
Some viewers may not start automatically.
In such cases, please export to PDF once and then 
print.

You can export the created storyboard as a movie 
by clicking on [ File ] > [ Export Movie ].
The exported video will be within the red frame 
shown. The red frame is automatically adjusted to 
16:9 aspect ratio. Everything displayed in the frame 
will be recorded. 
If you are in sheet view, you can save the sheet view 
as a movie. Zoom, rotation, orbit lines, etc. will be 
recorded as they are displayed.
Video export is available in AVI, MOV, and mp4 
formats. 
The frame rate can be set in the picture quality 
settings. The frame rate is about 30fps in high 
quality. Output in high quality requires several times 
the total video time.
AVI is uncompressed MOV is compressed by 
MPEG4. We recommend exporting in AVI for 
Windows and MOV for Mac. Utilize MP4 only for 
tablets. 
Export speed and image quality are greatly affected 
by the operating environment, including the 
presence or absence of codecs. Since the exported 
video is uncompressed data, the data size will be 
large. When distributing via e-mail, etc., please 
upload the video to a video site or use video editing 
software to compress the data before distribution.



Print out the coordination sheet (personal sheet)
Click [ File ] > [ Print ] > [ Coordinate Sheet ] to print a personalized sheet. 
Check the items you wish to add to the list and click [ Print ] to display the sheet as shown below.

[ Left-Right ] [ Front-Back ] indicates the distance and direction from the point.
Point names can be changed, modified, or added using the Point Maker in the Line Tools.
(Previous versions of the data do not have point names assigned, so they must be reassigned.)
Measures will not display properly unless measure settings have been made for the count.

In this case, Set1 moves 8 steps with a stride of half step (stride of 1 is 62.5) in the direction 
of ↓ with a movement of 8 counts in measure numbers 1-2. 
The destination points are,
 [R5] ・・・・ above the point 5 meters to the right of the center line
 1[FB0]   ・・point 1 step before the center [FB0].

Turn 180 degrees around left in beats 1-3, then down the horn in beats 1-2.
The notation for points is.
"Steps to the left [ name of left/right point ] Steps to the right" 
"number of steps forward [ name of point forward/backward ] number of steps backward." 
This is the rule.

When the Line tool is selected and in full sheet mode, 
a button appears.
Click      button to display the point.
For the setting items, check F-B if the point 
represents the front/back, and check L-R if the point 
represents the left/right.
 In the case of a forward/backward point, 
the left/right can be at any position.
 In the case of left/right, similarly, the front/rear 
position is free, so set it at a location that is easy 
to find. 
These point settings will be used when printing the 
coordination sheet. 
If you set too long names, the letters may overlap.

Example

4[R15]・・・・ From a point 15 meters to the right of the center line, 4 steps to the left 
[F10]2 ・・・・ 2 steps back from a point 10 meters in front of the center line 
[B5]     ・・・・ on a point 5 meters behind the center line
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How to use Point Maker



Upload to DSM server

Drill Studio Viewer

Upload to DSM server29
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By uploading the created drill data to the dedicated 
server, the data can be read by the smartphone or tablet 
version of the DrillStudioViewer app. 
When a file is uploaded to the server, a QR code is 
issued.
By simply reading the QR code from the smartphone 
app, the file can be downloaded and easily shared with 
other members. 
You can also share files by sending the download code 
via email.
The server is a dedicated server provided by our 
company, and uploaded data is stored for one year.
Files that have been uploaded for more than one year will 
be deleted. 
Please be sure to keep a backup of your uploaded files, 
as there is no guarantee against data corruption due to 
server trouble.
To use the DSM server, you must create and activate a 
Drill Studio Account.
You can create or edit your Drill Studio Account by 
accessing your account page from [ Help ] > [ Manage 
Account ].

Drill Studio Viewer is a mobile application that allows you to view Drill Studio files on your 
smartphone or tablet. 
It can be downloaded from app distribution sites (Google Play and App Store). 
The app is useful for understanding detailed individual movements, image training, and daily 
practice, as it allows you to check contests in real time and faithfully reproduces the contests 
created in Drill Studio.
Files uploaded to the DSM server can be easily downloaded to the app via QR code.



Useful Features

Shortcut key list

Copy & Paste [ Edit ] > [ Copy / Paste ]
You can record the position of performers in the order of their selection and reflect it on another 
sheet. You can copy and paste text boxes, lines, etc. (they will be pasted in the same position)

Undo & Redo　[Edit] > [ Undo / Redo ]
You can undo a work you have done. Note that there are some operations that cannot be undone.

Swapping Performer Positions [ Performer ] > [ Subsequent position swap ]
You can undo a work you have done. Note that there are some operations that cannot be undone.

Reversing the selection order [ spacebar ].
You can reverse the selection order of performers.

Useful Functions and Shortcuts30

The shortcut key is set by the Command (�) key on the Mac and 
the Control (Ctrl) key on Windows.

Control + Z

Contro l+ Y

Control + C

Control + V

Control + A

Control + S

Space ber

TAB key

←↑↓→

[Q] Show from previous point

[M] Model show

[L] Label show

[B] Display in black

[Y] Show sequential arrows

[X]

Show performer mark

[H] halt（Hold）

[G]

Auto order[A]

Show gridlines

[S] Snap

[I] Interval

[1] Rectangle selection

[2] Lasso selection
[3] Drag selection

[4] Standard selection
[5] Exclude selection

[6] Add selection

On / Off command (don't use modifier keys) When using the Object Tool

Show to next point[W]

Show area guide[E]

Move[W]

Scale [E]

Rotate[R]

Undo (Note that some operations cannot be undone.) 

Redo (Ctrl+z will redo the undone operation.)

Copy performer points, lines, text, etc.

Select all Performers

Save (Overwrite)

Reverse selection order (useful when using the draw tool)
Play and stop when no Performer is selected

Press and drag for the same effect as the Hand tool

Paste performer point, line, text, etc.
(Lines, text boxs, images are pasted in the same position as they were copied)
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Move the Performer or object when it is selected.
Hold down the [Shift] key and press the arrow keys to move one step at a time.
 When a count is selected, you can use the left and right arrows to fine-tune its 
position. 
If nothing is selected and the mouse cursor is in a sub-area, the left and right 
arrows will move the timeline.
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